
Part I

Preparation and Concepts for
Serious Image Editing

Serious image editing requires serious preparation. Problems in

your images that you can ignore when you are just starting out

become far more important as you gain experience editing.

What you don’t want to do when you work on images is spend

hours correcting something that would have taken moments to

fix at the time of capture. So your first task in working with any

image should be to always take the time to capture the best

image information that you can. Get the best capture as a photo

or scan, instead of one you will just plan to fix later. The better

the information you start with, the more likely you’ll have what

you need to make the best result.

Capturing the best information and getting the best results

require understanding the images themselves and how image

information is retained and displayed. Before getting into image

editing, there are some concepts that must be clear. Understand-

ing these concepts and setting up images correctly can help you

bring the right information into Photoshop Elements, optimize

image processing, and develop an approach to the processing

itself. This part of the book lays the groundwork you’ll need for

stepping into more advanced concepts.

Chapter 1 Essentials of Images and Image Editing
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Chapter 1

Essentials of Images and Image Editing

There are really only a few types of change that can be made in an image, and they revolve

around altering content. You choose the tools to use and then work with tone and color to

change the composition. That’s it. If your process covers tool selection, color correction,

and composition changes, you are doing what you should for every image.

Following a process and understanding the possibilities gives you a solid foundation to

work from. Although the actual changes for each image may be very different, you can use

the same set of tools and the same editing process just about every time. The purpose of

this chapter is to outline the process and concepts for you. With this foundation, you can

then jump into making your images better.

The Image Editing Process

The Tools You’ll Need

Basic Concepts of Tone, Contrast, and Color

Understanding and Using Color Management

Resolution

Knowing Your Equipment and Images
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The Image Editing Process
When you go on a vacation, it is a good idea to make a checklist to help you remember

everything you have to do before you go and everything you want to bring along. When

approaching image correction, a checklist can help ensure that you’ve covered all the

essentials. The list should cover everything you will have to do to an image, and you’ll

want to do the steps in a particular order until you develop your own preferences and

methods.

The process that follows is one that I have developed over many years of working with

digital images, and it covers all the steps you will need to take in correcting images. For

some images you’ll skip a step, and for others you might spend hours indulging one step

or another. During the process of correction, you will generally want to work from global

changes down to smaller and more specific changes.

The steps come in three parts:

Preparation Be sure your system and program setup are correct and that you know what

you want to do with the image.

Correction Take specific steps to achieve your goals in correcting the image.

Purposing Finalize the image to target it to specific output.

Image Correction Checklist
Each set of steps in the image editing process is outlined in the following checklist. Con-

sider this checklist your plan for editing images. It is the roadmap that all of the technique

covered in the following chapters falls into.

Preparation

1. Be sure that your monitor is calibrated and that you have set up your preferences and

tested your output. Doing so ensures your best chance of getting the results you

intend. (See “Understanding and Using Color Management,” later in this chapter.)

2. Store the original image file safely and work with a copy to do all of your image edit-

ing. If any step goes awry, you will want to be able to return to the original image to

start over, or you may want to repurpose the original in the future.

3. Consider resolution and color. Have in mind a target range for the resolution and a

color mode for the final image. You may work at different resolutions and in differ-

ent color modes throughout, but knowing what you need from the outset can help

you work smarter, with fewer color conversions (which you generally want to try to
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avoid). See “Types of Color” and “What Image Resolution to Use,” later in this

chapter.

4. Evaluate the image. This analysis can include looking at color and tone, determining

the image type (high-key, low-key, high contrast), evaluating the extent of work to 

be done, and considering the composition. The result of the evaluation should be a

short list of things you want to improve or change. See “Evaluating Image Tones” in

Chapter 3.

Correction

5. Make general color and tonal corrections. Be sure to make a good general correction

at this point, but don’t spend a lot of time getting it exact. A good general correction

will point out some flaws that may otherwise lurk in the image until later in the

process. While it isn’t bad to double back during the process, it can unnecessarily

increase the amount of time you spend on images. See “Redistributing Tone with

Levels” and “Snapping and Fading Contrast with Curves” in Chapter 3 and “Levels

Correction for Color” and “Curves Correction for Color” in Chapter 4.

6. Make general damage corrections, such as eliminating dust from scans, fixing cracks

and holes in scanned images, and reducing digital noise. See “Doing Minor Cleanup

First” in Chapter 3 and “Minor Cleanup for Color Images” in Chapter 4.

7. Make more involved color correction. This means do more intensive tonal and color

adjustments, but not spot adjustments (using selection or masking). Those correc-

tions will come later. See “Snapping and Fading Contrast with Curves” in Chapter 3

and “Curves Correction for Color” in Chapter 4.

8. Crop and size the image so that you are working with only the image area you really

need. See “Cropping as a Tool for Composition” in Chapter 6.

9. Make major specific compositional changes and corrections, including replacing

parts of the image with replacement parts you have created. This is the final composi-

tional change. See Chapters 6 and 7.

10. Make targeted color and tonal corrections to selected parts of the image. You’ll revisit

techniques from Chapters 1 through 7 to select and mask changes to specific areas of

an image. Chapter 5 might hold the most to mine in this step.

11. Make final fine-tuning adjustments to sharpening, contrast, and brightness.

12. Save the layered RGB version of the image. Be sure to give the file a new name, so you

do not save over the original.

the image editing process ■ 5
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Purposing

13. Simplify the image as appropriate. This step may include flattening the image or

merging layers, altering the color mode, or removing extraneous image information.

14. Make final color and tonal adjustments to optimize the image for output and use.

This step can include such changes as setting white and black points and making

device-specific color changes. See suggestions in Chapter 9, “Options for Printing.”

15. Save the image in output file format.

16. Package the image for output and use.

This checklist may seem long, but each step will often not be very involved. Some steps

you will do naturally, and some take just a moment. Practicing correction by following the

steps in the list can ensure that you make all adjustments and corrections that you intend

to in achieving your goals for the image. The tools to use in each of these steps are

reviewed in the next section. While this provides a solid process, using the process cor-

rectly depends on how well you understand your images. The sections that follow the

checklist provide the fundamentals you need to use the process.

The Tools You’ll Need
In each step of the image editing process, you can use a small subset of the tools and com-

mands in Elements to accomplish your goals. Having a list of these tools helps you know

what tools to concentrate on and master, while leaving other tools safely behind. Concen-

trating on the smaller tool set will help streamline your image processing and keep you on

target during the editing process.

The tool set listed in Table 1.1 is based on the steps described in the preceding section.

Most of these tools are standard tools you already have in Photoshop Elements; others are

add-ins you will find on this book’s companion CD. These “Hidden Power tools” can

simplify processes or add new functionality to Photoshop Elements. See the “Hidden

Power Tools” section of the book’s introduction for instructions on how to load and

access these tools.

You may occasionally reach outside this suggested tool set for a special purpose, but

this listing offers a general guideline to simplifying the tools needed to get excellent and

consistent results. The choices are based not on which tool is easiest to use, but on which

will provide the best results.

Don’t delete or merge shape layers that may be important to your output.
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P R O C E S S  S T E P T O O L U S E  T H I S  T O O L  T O  D O  W H A T ? L O C A T I O N

Adobe Gamma is on
your computer’s Con-
trol Panel or the Pho-
toshop Elements CD.
Display Calibrator
Assistant can be found
in the Displays System
Preferences by clicking
the Calibrate button
under the Color tab.

Save As File ➔ Save As

New File ➔ New

Image Size Image ➔ Resize ➔
Image Size

Mode Image ➔ Mode

Eyedropper Eyedropper tool in the
toolbox

Info palette Display sampled readouts. Window ➔ Info

Histograms Image ➔ Histograms

Levels Enhance ➔ Adjust
Brightness/Contrast ➔
Levels

Levels Enhance ➔ Adjust
Brightness/Contrast ➔
Levels

Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Clone Stamp Clone Stamp tool in
the toolbox

Healing Brush Healing Brush in the
toolbox

Masking Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Continues

Customize selections by using
masking.

Make smart brush-style corrections
via sampling of other image areas.

Make brush-style corrections via sam-
pling of other image areas.

6: Make general
damage corrections.

Adjust tonal levels and balance color
as a process.

Basic Color
Correction

Reduce color noise associated with
digital capture.

Reduce Color
Noise

Use simple sliders to adjust tonal
dynamic range.

5: Make general
color and tonal
corrections.

View image histograms as part of the
Levels dialog box display.

View a chart and statistics showing
tonal mapping of the image.

Sample to check color and tone val-
ues in specific image areas.

4: Evaluate the
image.

Use equipment settings to adjust
image color and resolution at capture.

Scanner or
digital camera

Change the image color mode of an
open image.

Change the size and resolution of an
open image.

Set the color, size, and resolution to
use for new images.

3: Specify resolution
and color settings.

Save your image with a specific name
and location.

2: Store the origi-
nal image.

Do free, easy monitor calibration and
ICC profile generation in one process.

Adobe Gamma
(PC) or Display
Calibrator Assis-
tant (Mac)

1 : Calibrate the
monitor.

Table 1.1

Tool Set

the tools you’ll need ■ 7

4385c01.qxd  11/7/04  11:27 PM  Page 7



Continued

P R O C E S S  S T E P T O O L U S E  T H I S  T O O L  T O  D O  W H A T ? L O C A T I O N

Copy Edit ➔ Copy

Paste Edit ➔ Paste

Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Separations category

Curves Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Hue/Saturation Layer ➔ New Adjust-
ment Layer ➔ Hue 
Saturation

Color Balance Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Crop Crop tool in the 
toolbox

Image Size Image ➔ Resize ➔
Image Size

Polygonal Lasso tool
in the toolbox

Masking Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Copy Edit ➔ Copy

Paste Edit ➔ Paste

Transform Reshape an isolated object. Image ➔ Transform

Guides Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools2 category

Add Noise Filter ➔ Noise ➔ Add
Noise

Continues

Roughen up tones that are unnatu-
rally smooth.

Place nonprinting edges for 
alignment.

Paste a copied area from the clip-
board into a new layer.

Copy a selected image area to the
clipboard.

Customize the visibility of layered
image parts and control the intensity
of selections.

Select regular and irregularly shaped
image objects.

Marquee and
Polygonal
Lasso

9: Make specific
compositional
changes.

Change the physical dimension
and/or number of pixels in an image.

Change the image size by cropping
out or adding extra canvas area.

8: Crop and size
the image.

Adjust color by balancing the influ-
ence of color opposites.

Adjust color by using slider controls
to alter hue, increase/decrease satura-
tion, and affect general lightness and
darkness.

Make custom multirange adjustments
to tone, contrast, and color by using
one of the most powerful correction
tools.

Split images into component colors
and tone (channels) to simplify and
target adjustments.

Luminosity
and Color,
RGB, and RGBL
separations

7: Make advanced
color corrections.

Paste a copied area from the clip-
board into a new layer.

Copy the selected image area to the
clipboard.
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Continued

P R O C E S S  S T E P T O O L U S E  T H I S  T O O L  T O  D O  W H A T ? L O C A T I O N

Gaussian Blur Filter ➔ Blur ➔ Gauss-
ian Blur

History Brush Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Gradient Map Layer ➔ New Adjust-
ment Layer ➔ Gradient
Map

Masking Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Blend Mask Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Unsharp Masking Filter ➔ Sharpen ➔
Unsharp Mask

12: Save the image. Save As Save with a new filename. File ➔ Save As

Merge Layers ➔ Merge
Linked, Layers ➔
Merge Visible, 
Layers ➔ Merge Down

Flatten Layers ➔ Flatten Image

Text To Shape Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools2 category

Mode Convert to final color space. Image ➔ Mode

Levels Make final adjustments to tone. Enhance ➔ Adjust
Brightness/Contrast ➔
Levels

Blend Mask Adjust white point. Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Continues

14: Optimize the
image for final out-
put and use.

Globalize type handling by convert-
ing type to vector layers.

Remove extra layers and image con-
tent when there are no vector layers
to preserve.

Remove extra layers and image con-
tent when there are no vector layers
to preserve.

13: Simplify as
appropriate.

Work with both local and fine contrast
in the image to improve edge defini-
tion and contrast in color and tone.

11: Make final fine-
tuning adjustments.

Influence specific tones and colors by
using tone and color measurement.

Customize the visibility of layered
image parts and control intensity of
selections.

Influence specific tones and colors by
using gradients.

Paint in adjustments from filtered
results (for example, to target Dodge
and Burn).

10: Make targeted
color and tonal
corrections.

Smooth out tones that are unnatu-
rally rough.
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Continued

P R O C E S S  S T E P T O O L U S E  T H I S  T O O L  T O  D O  W H A T ? L O C A T I O N

Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power
Separations category

Save As Save with a new filename. File ➔ Save As

Save For Web File ➔ Save For Web

DCS Templates Hidden Power Tools
folder included on the
book’s CD

The tools mentioned here will all be explored in this book as part of the exercises in

making image corrections. This listing cuts out many tools, most of which provide redun-

dant (and sometimes inferior) means of completing tasks. If you use these tools to follow

the methods described in the book, you will find that other tools are seldom necessary.

Several other minor tools will sneak in at points during the exercises; while they are not

specifically mentioned, they are mostly related to or substitutes for tools covered in the

categories in the list.

One tool that does not fit into any particular step, but is very useful, is the History

palette, shown in Figure 1.1. When doing serious correction and experimentation, it

should become a good friend. For example, when you have taken several steps that have

not accomplished what you hoped,

a single click on the History palette

can step you back to an earlier

point in the development of the

image so you don’t have to start 

all over again. This lets you undo

multiple steps at once, or compare

before and after changes at a click.

It’s a real time-saver and a helpful

tool.

Assemble the image parts and organ-
ize the content to complete purpos-
ing and storage.

Permanent
and/or tempo-
rary storage
devices

16. Package the
image for output
and use.

Use custom files to allow unsupported
color modes (CMYK and spot color).

Save Web images with limited color
and transparency.

15: Save in output
file format.

Create separations for print ready
files.

Separations
(CMYK and
Duotone)

10 ■ chapter 1: Essentials of Images and Image Editing
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Undone
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The History palette
acts like a multiple

Undo. Just click a
previous state, and

the image reverts to
the way it looked

then.
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Basic Concepts of Tone, Contrast, and Color
Without light, there would be no images. Light is what shapes the subject of images. It

strikes an object that you are photographing, reflects back through the camera lens, and

creates the color and tone captured in the exposure for the image. Light shapes the object,

because shadows and highlights reveal object contour. The subtle interplay of tones, con-

trast, and color gives shape to objects and defines the subject of an image.

Tonal range is the difference between the lightest and darkest image areas. The greater

the difference is between the lightest and darkest areas of an image, the greater the tonal

range. The way light and dark tones play against one another is contrast. The more stark

the difference is between light and dark image areas, the greater the contrast. If tonal range

and contrast are not balanced correctly, an image will appear too light, too dark, too flat,

or too harsh and contrasty, as illustrated in Figure 1.2.

Too light

Too harsh Balanced

Too dark Too flat

Figure 1.2

One image can look
many different
ways, but the best
way usually uses 
full range and flat-
tering contrast.
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Creating a dynamic image starts with making the most of the tonal range that exists in

the image. Contrast (or lack of contrast) between tones within that range helps define

image character. Not every image will naturally have high contrast and a broad tonal

range. Some images may be naturally high-key (light, usually with moderate to low con-

trast), low-key (dark, usually with moderate to low contrast), or simply low contrast. Usu-

ally, the goal of correction is to maintain the natural character, or key, of an image while

adjusting tone and contrast to enhance and improve dynamics. If there are 255 possible

grays for your image, and you use only 100 of those, the image is really only 40 percent as

dynamic as it might be. If you adjust the tonal range, the image can become more visually

dynamic; if you adjust with care, you won’t lose the natural quality of the image.

Both tone and contrast work in almost the same way in color and black-and-white

images: you want to make the most of and expand tonal range and dynamics while main-

taining image character. The difference is, when you extend the tonal range in a black-

and-white image, you get more potential grays; when you make similar adjustments in

color images, you get more potential colors.

Color as Tone
Color is a pretty simple thing to manage if you’re picking out clothes, drapes, or uphol-

stery. In those cases it is already mixed and applied for you. If you don’t have experience

with color mixing, it isn’t until the first time you actually try to correct the color of an

image that the complexity of color comes alive. If you’ve never had any training in art and

color theory, understanding how color works can be a little confusing. Add to that the

existence of different color modes (theoretical ways of defining color), and color becomes

still more complex. Even more confusion can grow from the fact that color is stored in

your digital images as grayscale. Because color can be split into simple grayscale compo-

nents, it is important to understand how grayscale (tone and contrast) can also define

color. However complex, you have to understand color and how it works in digital images

to apply it and achieve the results you want.

For the most part, images that you will work with in color will be in RGB mode. RGB

stands for red, green, and blue. It is an additive light-based color theory: different combi-

nations and intensities of red, green, and blue lights make up the set of available colors. As

the red, green, or blue lights are made brighter and applied with more intensity, the result-

ing color gets brighter, and colors mix in these varying intensities to form other colors.

Full intensity of red, green, and blue results in white; lack of red, green, and blue results in

black. It is a theory that works great with projection, such as on your monitor and some

projection TVs. Breaking images into their component RGB colors is how your monitor

displays color.
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Each color you see in an image is made up of

these three colors in different combinations. Each

of the three colors has 256 intensities in 8-bit

images (Elements does have 16-bit capability,

which is discussed more later in this chapter and 

in the “Bit Depth” section of the appendix). The

grayscale representations of the intensity of the red,

green, and blue are stored as grayscale information

in your image files. Light coming into a camera or

sensed by a scanner is actually broken into these

three components to be stored. Later the informa-

tion is reassembled, allowing your computer to

reproduce full-color images from the RGB.

This theory and practice have been around for

quite a while. One of the earliest photographers to

create color images did it in Russia in the early

1900s, before there was color film. Sergei

Mikhailovich Prokudin-Gorskii (1863–1944)

made glass plates three at a time when he took pic-

tures with a specially designed camera, filtering for

the red, green, and blue components of light to

record the strength (tone) of each component on

what was essentially grayscale film. The plates

would record the captured light as grayscale, and

then using a special projector, Prokudin-Gorskii

would project the images simultaneously with red,

green, and blue filters to reproduce the color images on a screen. Figure 1.3 shows one of

Prokudin-Gorskii’s images; a composited version of this image is also presented in this

book’s color section. (These plates are from the collection at the U.S. Library of Congress,

which can be accessed at http://lcweb2.loc.gov/pp/prokquery.html.)

Inside each of your color images are the primary source colors: red, green, and blue.

These source colors are stored as grayscale representations and mappings of the intensity

of red, green, and blue light in every pixel in your image. When you work on color images,

the changes that you make affect all three of the source colors at the same time. The

grayscale color components can be separated out of your images and retrieved for use in

adjusting your image dynamics, tone, contrast, and color.

basic concepts of tone, contrast, and color ■ 13

Red

Blue Composite

Green

Figure 1.3

This image by
Prokudin-Gorskii,
titled Man in Uni-
form, Seated on
Chair, Outside, was
taken around 1910
by separating color
into grayscale RGB
plates. Scans of the
glass plates can be
composited to
achieve a full-color
result (as shown in
this book’s color
section).
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Breaking down color information into color components may not always be to your

advantage when making corrections, but it can often be helpful when trying to isolate

damage and perform advanced color correction. The ability to make separations into

image components is a key concept of this book. If you understand how to make compo-

nent separations and how these separations combine to create your images, it opens a

world of possibility for improving images.

As Prokudin-Gorskii did in creating his “color” images, we can re-create representation

of color as grayscale by filtering digital images. When the color components are separate,

they can be adjusted one at a time, simplifying the way you work with color. This can help

when correcting color-specific defects, in simplifying an approach to images and correc-

tions, in developing a better understanding of what happens when you apply a tool to

color images, and in doing the most complex color alterations and corrections. Let’s look

a little more at color types and color management.

Types of Color
Color in your images can be measured in several ways. Photoshop Elements uses color

modes, which as I said earlier are really just different ways of depicting color and tone. The

following are the four modes you can use:

• RGB

• Indexed Color

• Grayscale

• Bitmap

Image color mode and file type are two very different things. Knowing which color

modes appear in which file types (and which file types to use with a certain color mode) is

often essential for correctly purposing your images.

Later in this section and elsewhere in the book I’ll talk about other color modes, including

LAB, CMYK, RGBL and Duotone. These are not technically working color modes in Elements,

but you can achieve these separations and save the separations to files using Elements.

Photoshop has a palette called Channels, which is not included with Elements. The Channels

palette, like the Layers palette, enables you to edit color components and manipulate them

separately (in RGB as well as other color modes). This can be a great tool in making complex

color corrections. Even though there is no formal Channels palette, this book shows you how

to access and alter channel information easily, just as if you had a Channels palette working

for you. The channels are referred to as components.

14 ■ chapter 1: Essentials of Images and Image Editing
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For the most part, people using Photoshop Elements will be working with 8-bit color

images in RGB mode. This mode offers the broadest flexibility for tool use, and is the

mode most images are in when captured or created. As I have said, RGB refers to the type

of color storage; in this case information is stored as red, green, and blue components. 

8-bit refers to the exactitude of the color representation, or the number of variations that

can be stored per pixel in a color component. There are 16 million potential colors in 

8-bit RGB, based on 256 possible tonal variations in each of the three color components

(256 × 256 × 256 = 16,777,216 possible variations). That’s one big box of Crayolas! In

fact, it is the largest color set of any of the color modes you will be working with in Ele-

ments, except when using 16-bit RGB. A larger number of possible colors in your image

allows finer distinction between colors and helps changes that you make to images blend

more evenly.

16-bit is perceived to be an advantage over 8-bit: with 35,184,372,088,832 potential col-

ors, images can theoretically have better integrity, and changes are less apt to damage

image information. When working with 16-bit images, however, some important tools

and functions are not available for image correction—most notable of these is layers.

Other drawbacks to 16-bit include greatly increased file size, greater computer horsepower

needed to process the images, and the lack of ability to use output from a 16-bit file (at

present, information must be converted to 8-bit for print processing and display).

Generally, you will work in 8-bit RGB for the best access to tools and the most pre-

dictable behavior of images. When the image is complete (that is, all changes you are

going to make have been made), then you can consider converting the RGB image to

other modes as required for your final purpose. You can save RGB files in many formats,

but you will probably most often use TIFF (print), Photoshop (archive), JPEG (Web), and

PDF (portability).

Indexed Color is a much more limited color mode than RGB and is almost always asso-

ciated with GIF Web images. This color set has a maximum of 256 colors. The colors are

created as a table by using hex values: six-character codes that represent specific colors (see

the Hex Code Chart on the Hidden Power CD). The colors cannot be mixed, and must be

one or another of the colors in the table. The goal of limiting colors, especially in the case

of Web images, is to simplify files and make them smaller. In the case of Web images, this

helps transfer them more quickly.

Regardless of what you read elsewhere, 8-bit files can be returned to 16-bit in Elements. This

will not magically restore 16-bit information that may have been lost or unavailable, but it

will enable you to restore the advantage of 16-bit editing to 8-bit images. See the “16-Bit

Images” sidebar later in this section.
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Even without any experience in converting to Indexed Color from RGB, it may be

obvious that converting all of your 16 million potential colors from an 8-bit RGB into a

measly set of 256 colors for Indexed Color may not always produce the best results. In

converting to Indexed Color from RGB, almost all of your original color will have to

change. Of course, the results can be disastrous when imposed on a full-color image.

However, there are color tricks (such as dithering) that can make Indexed Color’s color

sets appear larger than they really are. Because color is applied rather than mixed, Indexed

Color is a difficult color mode to work in. Moving to this color mode will almost always be

a last-step conversion, and almost always will be done in converting images for display on

the Web (when JPEG is not used). They are almost always saved in GIF format.

Grayscale (Figure 1.4) is also limited, but to no color at all. This “color” mode has 256 lev-

els of gray tones (in 8-bit mode) that make up all you see in standard black-and-white images,

or when working with individual color channels (such as color components extracted from

RGB images). Generally you should convert images to grayscale when you are printing

images without color, so that you can get the best depiction of tone (without depending on

the color device to convert color for you). Taking the color out of an image can be simple, but

it can also be considered an art, because what looks good in color may not look good at all in

a straight conversion to black-and-white (though we will look at various ways to improve

your results). Grayscale images are most often used in black-and-white print jobs.

Bitmap images are like grayscale, but are more strictly formed in black or white—using

no grays. Pixels are either white (off) or black (on), as illustrated in Figure 1.5. For the most

part, bitmap images are used with line art (pen-and-ink-type line drawings). Bitmap will

probably be the least used color mode of those available. You will probably save Bitmap

mode images in TIFF or BMP formats. High-resolution bitmap images are sometimes used

for line art and other special purposes for print, such as creating dithered drop-shadows for

use in layout.

b

c

a

Figure 1.4

Grayscale gradients
showing black-to-
white gradients in

(a) 10 steps (10 per-
cent darker in each),
(b) 25 steps (10 lev-

els darker in each)
and (c) 255 steps

(every level of gray).
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CMYK color (depicting images with cyan, magenta, yellow, and black) is a common

printing color scheme that is not really available to Elements users as a color mode. It is

how color is most often depicted in print. While you will not work in a CMYK color mode

in Elements, you will usually print with CMYK color. The theory is similar to RGB in that

a limited set of colors are used as inks to create the visible color set. At the same time,

CMYK is perceptually the opposite of RGB. While RGB is based on additive color (the

more light or color you add, the brighter it gets), CMYK is subtractive (the more ink/color

you add, the darker it gets, because the light striking the color is absorbed). Figure 1.6

shows how two ink halftones combine for a darker result.

These BMP bitmap images are different from the color bitmaps used in screen shots and

other images as a common file format on Windows computers.

Figure 1.5

The magnification of
a portion of the orig-
inal bitmap image
reveals the bitmap
patterning.
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Conversion from RGB to CMYK is often disappointing, because CMYK can portray

fewer colors even though there is one more color in the set. The easiest way to understand

this is to consider efficiency. While light is pretty much 100 percent efficient when pro-

jected, the absorption of light by ink pigments is not. Because pigments do not provide

perfect light absorption, the color they reflect is not perfect in conversion. Black is added

to the CMY color set as an attempt to increase the efficiency of absorption. As an additive,

it produces only redundant color (color that should have been reproducible in a 100 per-

cent efficient CMY pigment set). As a result of the inefficiency, the CMYK color set suf-

fers, and results in less dynamic color and tone than RGB.

There is a supposition that you cannot work with CMYK images in Elements because it

is not a supported color mode, but this is not entirely true. Although the program is not

set up to handle CMYK directly, an indirect approach can enable you to make custom

CMYK separations and usable CMYK images that can help you improve printed output.

The file format used with CMYK is often TIFF, PDF, or Photoshop EPS. Regretfully, none

of these will work directly. However, later in the book I will show you how you can essen-

tially hijack another file format (DCS: Desktop Color Separation) that will allow saving

and manipulating files as CMYK.

1 6 - B I T  I M A G E S

Some users wonder—and even worry—about using 16-bit mode for image editing. 16-bit

images offer more color detail: whereas 8-bit can reproduce “only” 16 million colors per pixel,

16-bit can reproduce more than 35 trillion (based on Photoshop’s color handling). While this

difference between 16-bit and 8-bit may be significant for archival purposes, for most cases

in the real world, it should not make a noticeable difference in your images. You might see

the difference if you are making extreme changes to an image or trying to rescue image

detail from shadows and highlights. However, most output devices can’t handle the addi-

tional image information in 16-bit images, and it is questionable whether technology will

meet the 16-bit challenge in the near future, or if human perception can really distinguish

between the results.

+ =

Figure 1.6

Samples of black
(45°, left image) and

cyan (108°, middle
image) halftone dots

as grayscale. When
the halftone dots are

printed over one
another (right), col-

ors combine to
absorb more light.
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Photoshop Elements supports some 16-bit color adjustment as of version 3. Previously it

would convert 16-bit images to 8-bit when opening. The only real gain you have for 16-bit images

is in importing original 16-bit information or temporarily extending the usable color space for

your images while you work on them. If you have a camera or scanner that creates 16-bit images,

be sure, as suggested, to store copies of original images before converting to 8-bit.

When possible, working in 16-bit rather than 8-bit can provide an advantage for grayscale

images, arguably more so than color. The measly 256 colors in the single grayscale compo-

nent can more easily run out of image room and variation than the 16 million variations per

pixel in 8-bit color. While you can’t apply all tools in 16-bit (Elements does not, for example,

support layers with 16-bit images), you can make some corrections using 16-bit, and you can

switch back to 16-bit after making 8-bit modifications (using Hidden Power techniques).

To temporarily switch to 8-bit, do the following:

1. Have a 16-bit image open.

2. Duplicate the image (File ➔ Duplicate).

3. Put your new filename in the As field. For this example, use Temp 8-Bit. Click OK.

4. Change the mode of the Temp 8-Bit image to 8-bit (Image ➔ Mode ➔ Convert To 

8-Bits/Channel).

5. Make any corrections you want involving layers, and so forth, that you can’t do in 16-bit mode.

6. Make a selection of the entire image using Select All (Command/Ctrl+A), Copy (Com-

mand/Ctrl+C). Then activate the original 16-bit image and Paste (Command/Ctrl+V).

When you paste, the image information you have been manipulating in 8-bit will convert

to 16-bit. There are, of course, some limitations to the effectiveness of this conversion, but

you can return to 16-bit mode and save the manipulation as a 16-bit file.

You can also convert files that were originally 8-bit images to 16-bit:

1. Have a flattened 8-bit image open. Check the Height and Width in pixels by using Image

Size (Image ➔ Resize ➔ Image Size) and note the values.

2. Make a selection of the entire image using Select All and Copy.

3. Open the Hidden 16.psd image on the Hidden Power CD.

4. Resize the image (using Image Size again) to the Height and Width determined in step 1.

Accept the changes by clicking OK.

5. Paste.

This will paste the 8-bit information into the 16-bit file, converting it during the process.

Changes that you make while in 16-bit mode will reflect the advantages of 16-bit files. You

can now fluidly move from 8-bit to 16-bit files in Elements. 

See the appendix for more information on 16-bit images.
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Understanding and Using Color Management
A buzz phrase in image correction is color management. If you are not familiar with this

term, or if you have heard of it but don’t know quite what it is, this section covers most of

what you need to know. Although it is something you should take seriously, color man-

agement does not have to be as complex or mysterious as it tends to be. This brief discus-

sion will help you become familiar with it, poke it with a stick, and see that it is dangerous

if completely ignored. We’ll look at your options, get set up, and get on with the main

course of editing images with confidence as you pass color management by with a better

understanding and a knowing grin.

Color management is supposed to be a means of helping you get better color consis-

tently. That sounds good, and it is usually the reason why people think it is something

they can’t do without. By using color management, the goal is to have a better chance of

your images looking the same from a variety of outputs (print and display). Color man-

agement uses profiles that describe how your display handles color to help translate what

you see to other devices and how those devices handle color (via a common color palette

and profiles of those other devices). The profile from your monitor or working color space

can be embedded (saved) with your image file to act as the color interpreter for other

devices (monitors and printers).

Every device has its own profile, which acts as the interpreter on its end, so the devices

can speak the same color language and adjust for differences. The key to full color man-

agement is that every device has to have a profile to be able to interpret other profiles, so

the translation will work reliably. The embedded profile will affect images behind the

scenes, both to help represent color correctly on-screen and to serve as a translator to

other devices. In theory, that results in a better image. All this automatic translation

sounds very appealing, like I’m serving the chocolate cake first.

This is all nice in theory, but the sad fact is, it doesn’t necessarily work in practice.

There are a lot of points in image processing where detours or errors can occur. Your

profile can get dropped, changed, or ignored, or it can just plain be wrong. Profiling can

occur where you don’t expect it, and other profiles can be wrong, causing information in

your image to be misinterpreted. Any of these can cause unexpected results.

First, you are responsible for building yourself a color profile—unless you use a

generic one (not recommended). You have to set up the profile correctly, and there is

no guarantee that you will (even if you follow instructions) because the process involves

This section deals only with Elements Color Management options. For more information on

using printer profiles, see the “Printing with a Profile” section in Chapter 9.
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your assessment of color by eye (if you don’t use a profiling device), and that may not be

entirely accurate. Second, every step between saving your image and sending it to the

printer has to both respect the color management and process it correctly. This is where

the chocolate cake turns to mud pie.

Although profiling was planned to function behind the scenes and stay with your

image, you can’t be sure that the results you get are based on the choices you have made to

embed your monitor profile in the image—unless you manage each step of the process.

You also can’t be sure that you really want the process to respect your profile (for exam-

ple, if it is not correct). Embedding a profile doesn’t work consistently because it can’t be

enforced: even if you embed a profile, some device or person along the way can drop your

settings. There are devices that don’t recognize color management settings; there are serv-

ices that don’t use them in processing. If your results depend on the color management,

and the wrong color profile is embedded or the profile is missing, you are just as likely—

or more likely—to get a bad result than you are without embedding color profiles.

Your only chance for guaranteed success using embedded color profiles is to make a

study of how the profiles work, and become intimately knowledgeable about the output

types and processes you use. Reading your printer manual is not necessarily intimate

knowledge; it goes somewhat deeper than that.

Even with this additional effort, using color management and embedding profiles

requires testing. Funny thing is, you have another choice: not embedding profiles. Not

embedding profiles can have pitfalls and also requires testing. It does, however, remove

the potential added complexity of using embedded profiles. In the long run, if you set up

your system correctly by calibrating your monitor and creating a monitor profile (an ICC

profile that describes your monitor) , not embedding profiles can often lead to more pre-

dictable results. You should not entirely dismiss color management, and you should create

a monitor profile—even if you are not embedding profiles in your images. This helps cali-

brate your monitor and adjust the view of your screen. Embedding profiles in your

images, on the other hand, is like an extra half-step in a staircase that can just as likely trip

you up as ease your progress up the stairs—depending on how much you are paying

attention. My experience is that you are more likely to trip over that half-step and swear at

it than praise it.

None of this is to say that you can’t embed profiles with success! You can, and if you 

do currently, don’t change what you do. My perspective on using or not using profiles is a

lot like my perspective on images: don’t change what works, change what doesn’t. If you

currently use embedded profiles and everything works fine, stay with them. If you don’t

use profiles with success, don’t use profiles, or you have never looked at them, or you
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don’t understand what they are and how to use them, practice color management with the

following fast, safe, and effective system:

1. Calibrate your monitor and create a monitor profile (I’ll show you how to do this in a

moment).

2. Don’t embed profiles.

To be reasonably successful with color management, the Photoshop Elements user

needs to calibrate, create a monitor profile (which Elements uses for image viewing), and

choose how to handle profiles by making a selection in Color Settings. Even if you choose

No Color Management, you are still using color management—you just choose not to

embed profiles in your images. Calibrating your monitor and creating the monitor’s color

profile helps ensure that you see a best representation of the images on your display. This

best representation should show what your image will look like on most other displays—

and, for the most part, what it will look like in print. The next few sections present in a lit-

tle more depth what you should expect to see on your monitor, how to calibrate, and what

to do to build an ICC profile for your monitor.

What You See Should Be What You Get
One problem with trusting your visual sense is that it assumes that what you see on-screen

is the right thing. Regrettably, that is not probable without calibration. All monitors are

different, and the settings for display and color will affect what you see. If you haven’t cali-

brated, colors on your screen might look different from colors on someone else’s—and

worse, they might not match or even come close to the color that gets printed.

If you are looking at a screen that is shifted green and you depend on the color to be accu-

rate, a good correction will tone down the greens to make the image look right on-screen.

This will cause output of any kind to be shifted toward reds (the opposite of green). Calibra-

tion will help compensate for shifts by flattening the response of your screen.

The goal of calibration is simple: you want to be able to trust what you see on your

monitor, within reason. If you can trust what you see, you can mostly use your visual

sense to correct your images.

I say mostly because even if you’ve calibrated your monitor, you have merely adjusted it

for best performance. You are going to get the most out of your monitor, but the monitor

itself may have some limitations—and there are inherent limitations in printing, so it is

likely that there will be some differences between what you see on-screen and the result in

print. Although you probably won’t reach perfection, calibrating your monitor gives you a

far better chance of at least coming close. With some selective checking, you should be

able to feel confident in what you’ll get as a result.
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Calibrating Your Monitor and Building an ICC Profile
In this section you’ll look at how to calibrate your monitor and create a monitor profile.

Creating the profile helps your system adjust previews so images on-screen appear accu-

rately. Before you begin, you should know several things about the response and perform-

ance of your monitor, including the manufacturer-suggested color temperature, gamma,

and phosphor settings. These settings should be available from the manufacturer (call tech

support and ask for an engineer if necessary).

What you use for calibration may vary. In the past, Adobe provided Adobe Gamma for

monitor calibration for Mac and Windows users. It is no longer provided for the Mac

because the Display Calibrator Assistant is a standard utility on OS X and above. Wizi-

WYG is another free utility from Praxisoft for Mac and Windows, available from their

website (www.praxisoft.com).

In the following steps, I describe the sequence (and show the screens) of Adobe

Gamma for Windows; alongside these, I include some matching screens for Display Cali-

brator Assistant for Mac OS X(the order will be slightly different). Each of these utilities is

similar in respect to what they do, and any will work for purposes of calibration and creat-

ing the profile. For the most part, you can simply start them up and read the directions as

they appear on-screen. If you are lucky enough to have a calibration device (such as the

Spyder by ColorVision), use that for calibrating your monitor instead of the following

procedure; calibration by hardware calibration devices will be more accurate than calibra-

tion by eye.

Color temperature reflects the monitor display color for the white point, which really

measures the color of white on your monitor. It is usually 6500, 7500, or 9300 degrees on

the Kelvin scale. The higher the number, the more blue (or cool) there is in the white; the

lower the number, the more red (or warm) there is. It is an inherent characteristic of your

display and can subtly affect the appearance of color on-screen.

Gamma is a measure of tonal response, often a number between 1 and 3 with two deci-

mal places. Phosphors are a set of six numbers with x and y coordinates for red, green, and

blue; these numbers can have up to three decimal places. These settings vary between

monitor brands and models, so don’t make assumptions about them or copy someone

else’s. Find the settings in your manual or contact the manufacturer (via the website or

technical support—again asking for an engineer if necessary).

Monitor manufacturers don’t always put monitor specs for phosphors, white point, and

gamma in the manuals. You’ll likely have to seek it out. When you obtain the information,

write it down. I usually write the settings right on the cover of the monitor manual for easy

reference.
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Your monitor should be in an area that will minimize glare, and lighting (except where

noted during the calibration) should be as you will have it when you are most frequently

using the computer and monitor. Lighting should generally be subdued and indirect if

possible. Changes in lighting will require recalibrating the monitor. The monitor can be

calibrated to different light conditions, but it is easier to maintain a consistent room light-

ing than to add it as a variable in color corrections. Extremely bright or overly dark rooms

might cause some problems with calibrations and monitor viewing. Optimally, room

lighting should be bright enough that you can read and view materials that are not on the

screen, yet not so bright that it causes glare or washes out the display. After creating your

profile, be sure the lighting where you work remains the same as when you calibrated the

monitor.

Before you begin, you should also locate the monitor’s brightness, contrast, and color

controls. If your monitor has an option to reset to factory settings, do it now. If there is no

reset option, use the monitor controls to normalize the screen by eye. Grays should look flat

gray rather than a little warm or cool. After resetting or adjusting color, leave these controls

alone and do not change them after calibration. Now you are ready to start calibration.

1. Turn on your monitor and system, and let the monitor warm up for at least 30 minutes.

2. If you haven’t done it yet, read the owner’s manual for the monitor to see if it pro-

vides suggestions for calibration.

3. Open Adobe Gamma by double-clicking the icon in the Control Panel folder. You

should see the screen illustrated in Figure 1.7. If Adobe Gamma is not in the Control

Panel folder, find it on the Photoshop Elements CD.

Figure 1.7

The initial Adobe
Gamma and Display
Calibrator Assistant

screens

Calibration will be slightly different in every operating system and OS version, though the

options in various dialog boxes will be similar.
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4. Click Step By Step. This will lead you through the process of calibrating and creating

an ICC profile for your monitor. Click the Next button.

5. In the Description field, type a name for the profile you will be creating (Figure 1.8).

You can enter a lot of information here, but it’s best to keep it short. I find it handy to

name the monitor and add the date, so the profiles are easy to identify. If you use out-

put white point settings (step 12), you may also want to include this value in the

name. Click the Next button.

6. Using the monitor controls, set the contrast all the way up and then adjust brightness

until the smaller gray box in the center is dark enough that it is just barely discernable

from the larger black box surrounding it (see Figure 1.9). If you notice the white

frame beginning to darken at any point, stop darkening the screen. If necessary,

adjust the brightness setting to lighten the screen a bit until the frame is bright white

again. As you fine-tune this adjustment, it may help to squint or use your peripheral

vision to get the center square as dark as possible without losing the brightness of the

white frame. When you are satisfied with the adjustments, click the Next button.

Figure 1.9

Concentric squares
in Adobe Gamma, or
a square and oval in
Display Calibrator
Assistant, help you
adjust the screen
contrast by observa-
tion while making
adjustments to the
physical monitor
settings.

Figure 1.8

Type the profile
name in the
Description field.
(The opportunity to
name the calibra-
tion comes last in
Display Calibrator
Assistant sequence.)
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7. On the screen that appears, select Custom to open the Custom Phosphors screen

shown in Figure 1.10.

8. Type the six values obtained from the manufacturer of your

monitor in the appropriate fields. You don’t have to know what

each number means, but you do have to place each one cor-

rectly. Click the OK button to close the Custom Phosphors

screen and accept the changes. This returns you to the Adobe

Gamma Assistant dialog box.

9. Click the Next button. The screen that appears (Figure 1.11) enables you to adjust

gamma. Select the View Single Gamma Only check box. Using the slider, adjust the

appearance of the outer square (the alternating lines of black and white) so that it

matches the tone of the 50 percent black center. Adjust the appearance by squinting at

the screen (to blur the box slightly in your vision) while moving the slider. The goal is for

the entire square to seem to have a uniform tone.

10. In the Gamma field, type the Gamma value you got from the manufacturer. You will

be able to enter a two-decimal value, but Adobe Gamma will round the value off

when you save the entry.

Figure 1.11

Sliders help you
visually adjust for

the monitor gamma.

If you change monitors, you will obviously have to build a new profile. Other less-obvious

reasons to build a new profile are monitor aging and changes in response due to use, replac-

ing your system hard drive, and changing room lighting (or computer placement).
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Phosphor values
describe the moni-

tor’s response to
color. (Display Cali-

brator Assistant
does not allow cus-
tom value entries.)
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11. Click the Next button. The screen that

appears (shown in Figure 1.12) allows

adjustment of the monitor’s white point.

Set the monitor’s white point by choos-

ing the value in the drop-down list that

corresponds with the number you got

from the manufacturer. (If you do not

know what value to choose, see the fol-

lowing note.)

12. Click the Next button. The screen that appears (Figure 1.13) will enable you to select

a white point for output. This selection should be based on the color temperature of

the intended output media. If you are unsure, or you are creating images for the Web,

use the Same As Hardware setting.

13. Click the Next button. The next screen (Figure 1.14) enables you to compare calibra-

tion before and after the adjustments you made in the previous steps. Click to toggle

the Before and After buttons several times, comparing the appearance of your screen

as you toggle back and forth. Specifically, note the grays in the dialog box and see

whether the color appears more neutral before or after adjustment. The more neutral

(lacking any color, and looking flat gray), the better the calibration.

Figure 1.13

Output white point
differs from monitor
white point. This set-
ting should reflect
the color tempera-
ture of your output.
This may be another
monitor, paper, or a
projection screen.

A second option on this screen enables you to measure the white point. To do this, dim (or

turn off) the lighting in your work area and click the Measure button. A set of three gray

squares will appear on a black background. Click the square that seems most flatly gray and

repeat until the test closes.
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White point is a
measure of the
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est parts of your
monitor, measured
in degrees Kelvin.
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14. If the before and after results are noticeably different, run through the process again

(steps 3 to 13).

15. Click the Finish button to accept the changes.

What you have just done is calibrated your monitor and created an ICC profile for it.

The calibration helps you to be sure the image information you see on-screen is reason-

ably accurate. The ICC profile is a description of how color appears on your system. This

information is used for previews, and can be used if you embed profiles in your images to

help describe color in your image to other ICC-aware devices.

Although Adobe Gamma is an adequate tool for visual calibration, calibration devices

(see the example in Figure 1.15) can measure more accurately than your eye, and will

probably measure a greater number of gray levels and create more accurate profiling. The

devices take measurements directly from your screen and create a profile based on those

measurements. Using such a device can ensure that your monitor is calibrated properly,

and it may actually save some time during calibrations.

Color Preferences
Most Preferences settings in Photoshop Elements are just a matter of personal preference,

and they can be changed at any time as you see fit. However, the one group of settings that

you will be required to make a choice about and stick to is Color Settings. This is where you

can define how Elements handles images with profiles that you open, what color space you

want to work in, and whether profiles get embedded in your images by default. The choice

you make can be important to your results, and will certainly affect how you work with

images. If you are not sure about what to

select, or if you are unfamiliar with some of the

terminology just used, that’s OK. Your options

and explanation of terms are covered here.

Before we dive in: how much of this do

you really need to know? Probably not that

much if you use the techniques suggested in

this book. The following explanation

attempts to clarify why certain suggestions

are made.

I never calibrate one time and sit back satisfied—even when using a calibration device. I run

through the process a few times to be sure I have the best calibration.
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Understanding Color Space

The color space is a defined color set—a mapping of what colors are possible for your

image. Some spaces are said to be larger than others, and this isn’t technically accurate. All

8-bit RGB images have the same number of potential colors. On the other hand, different

RGB color spaces are mapped to cover a wider or smaller range of potential colors—not

bigger color spaces with more colors, just broader spaces that cover a greater range.

Because different RGB color spaces map to different color sets, all RGB is not the same,

though it is born of the same theory.

The difference between one color space and the next is the range or set of colors that

the color space covers. In other words, the numbers in two files defined by different color

spaces can be exactly the same, as numbers, yet the display or print result would end up

different because the numbers in those files represent different colors (however slight the

difference). What you really need to focus on here is what the mappings intend to cover.

You can know the name of the color space, but that may not tell you a lot about what you

are working with. Two common workspaces applicable to Photoshop Elements are sRGB

and Adobe RGB.

Each RGB file has the same number of potential colors—no matter what color space you

choose to use.

Figure 1.15

The ColorVision Spy-
der device attached
to a monitor
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sRGB is a “limited” RGB color space in that it assumes some limitations of a common

RGB monitor to display all RGB colors. Because of inherent limitations in monitor pro-

jection, sRGB is mapped to enable you to record color in your files that most monitors

should display correctly. All this really means is that colors are not mapped to the full

potential gamut of RGB. The images you make in sRGB color space are more likely to be

compatible with what can generally be displayed on other monitors. In other words, it is a

generic and friendly color space if you are sharing images for viewing on monitors. This is

usually the assumed profile if an image is not tagged (that is, does not have an embedded

profile).

Adobe RGB (1998) is a wider-gamut RGB color space than sRGB. It maps to a color set

that attempts to better describe colors available on CMYK printers (notably purer cyan).

Because it maps a broader range of colors than sRGB, Adobe suggests that it may be a bet-

ter choice for working with images that are intended for print. The drawback to using

Adobe RGB is that you may be manipulating color that you can’t see accurately on screen.

If color management actually works as designed, however, optimized images for either

Adobe RGB or sRGB should appear very nearly the same on monitors or in print.

When you’re working with your images and profiles are not embedded, devices using

the color file have to make an assumption about the color space. Generally the assumption

will be that a generic RGB space was used; that means sRGB rather than Adobe RGB.

Therefore, numbers may be interpreted differently than you intend. An Adobe RGB image

opened as an sRGB image will desaturate because of the wider gamut numbers being

mapped to the smaller gamut color space. The only real choice when using Adobe RGB is

to embed the profile (tag the files as Adobe RGB) and ensure, along the route of the image,

that the profiles are respected. In other words, using Adobe RGB is a commitment to

using embedded profiling and, most likely, full color management.

A third profile you can use for color management in Elements is the custom ICC monitor pro-

file you created for your monitor after calibration. You’ll see it as the Embed Color Profile

choice in the Save As screen when you are using No Color Management—if you have cor-

rectly set up the profile per earlier instructions. This profile attempts to describe the way your

monitor handles color. It is used by Elements as a means of attempting to create an accurate

preview of colors in conjunction with your working color space.

The difference between color spaces is the range of color in their mapping.
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The Color Settings Dialog Box

The Color Settings dialog box pops up the first time you open Elements, before you do

anything. If you have already dismissed this (or want to change preferences after reading

this), you can revisit the settings by opening the Color Settings dialog box (Edit ➔ Color

Settings), which is shown in Figure 1.16. The three choices seem straightforward enough,

but the names really don’t tell you what the settings do—and they may be a little deceiv-

ing. People might choose Full Color Management simply because that wording seems the

most savory choice. Regretfully, that may not be the best choice, and the Help button isn’t

much help.

Here are descriptions and some important background information for each choice:

No Color Management This choice ignores any existing profile in an image if one is pres-

ent when you open it. On saving, Photoshop Elements will not embed a profile with your

image. The option to embed a profile is available by choosing Save As from the File menu;

to embed a profile, you simply select the Embed Color Profile check box. The profile

embedded will be based on the ICC profile you created for your monitor.

If you change the Color Settings while an image is open, changing to Limited Color Man-

agement will offer the option to embed the sRGB profile if using Save As, but will not

embed a profile otherwise. Changing to Full Color Management will save a profile fitting

to the current color mode (these options are outlined in the following description for Full

Color Management).

Limited Color Management Selecting this option will convert the image to sRGB when it is

opened using whatever profile is included. The resulting image will use the sRGB color

space. On Save, no profile will be embedded. The option to embed is available using Save

As, and the sRGB profile will be embedded if you choose this option.

If you change color management settings while the image is open, changing to No Color

Management will allow you the option of saving by manually embedding the monitor

profile you created. Changing to Full Color Management will save the image with a profile

fitting to the color mode (these options are outlined in the following description for Full

Color Management).

Figure 1.16

Many users may not
understand what
the options on this
dialog box really
mean.
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Full Color Management This option retains a color profile if it is present in an opened

image. On Save, the original profile will be retained with the image. The option to disable

embedding the profile can be found in the Save As dialog box. Opening a new image or an

image with no existing profile will cause Photoshop Elements to retain the profile with the

image based on the color mode. These choices are the same when changing Color Settings

while an image is open:

RGB will have the Adobe RGB (1998) profile.

Indexed Color will have the Adobe RGB (1998) profile.

Grayscale will have a Dot Gain 20 percent profile.

Bitmap will have no profile.

Notice that if you want to ignore, convert, retain, or embed a profile , you can do that

by manipulating the Color Settings before and after an image is opened. Changing Color

Settings in midstream will enforce different rules and create different results. This may be

a pain, and it is something you probably won’t do very often, but it can come in handy

when you get a bad profile or when an opened file does not convert during opening the

way you think it should. Attempting to open the image by using different settings might

improve the initial result.

It is really a personal decision as to how to manage color. However, the level of complex-

ity and unknowns in working with images seems to rise quite a bit if you choose to embed

profiles and use working spaces outside of the more standard sRGB. It is likely that by using

optimal techniques for correction (as defined by this book), there should be little difference

in your results no matter which color space you use. This is why I suggest using No Color

Management and simplifying the workflow. Personally, I work with color management off

until I get an image that has a profile embedded. In that case, I might try to open the file by

using different Color Settings to see if I get a better-looking conversion. Otherwise, I stick to

the things I normally do because I can depend on my normal workflow to get consistent

results. I almost never embed a profile unless it is specifically requested.

Resolution
Put as simply as possible, resolution is a measure of potential detail in your images. High

resolution suggests that there will be intricate detail; low resolution suggests that detail

may be compromised. It would seem, if this description holds, that you would always

want high resolution if you consider detail important. But that’s not always the case. What

you really want is the correct resolution, and this depends not only on what size you want

the result to be but also on what medium you will be using. Output and display can use

image resolution in different ways, so the result doesn’t depend only on what the resolu-

tion of the image is; it depends on how much there is as well as how it is used.
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In print, if you don’t have enough resolution to meet the needs of the output, images

won’t look as sharp as they could; if you have too much, file sizes are unnecessarily large

and processing will take longer than it needs to—and the results will not improve. On the

Web, images without enough resolution will be too small; those with too much will be too

large. This rule also carries over into other display-based technologies such as film

recorders, which make high-resolution images on film from digital files. You can’t just

guess how much image information you need; you have to know the amount you really

need and work within those parameters. Understanding what resolution is and how it is

used is the only way to use it correctly.

While dpi is really an output term, it’s often used casually as a universal term for reso-

lution (spi, ppi, dpi, and even lpi). The various resolution-related terms can be tricky to

use correctly and consistently, but you should know what they mean and use them prop-

erly when you mean something specific. To simplify with better accuracy, use spi when

speaking of capture (scan sampling), ppi when discussing digital files, dpi when consider-

ing output resolution, and lpi in the context of halftone dot size.

spi (samples per inch) Capture resolution. The number of scanning and digital capture

samples per inch.

ppi (pixels per inch) Digital file resolution. The assigned number of digital pixel elements

to be used in printing or display of an image.

dpi (dots per inch) Printer resolution. The number of bitmap dots (smallest printing com-

ponent) an output can create per inch.

lpi (lines per inch) A measure of halftone dot size. Halftone dots are made of multiple

printer dots. The number of rows of halftone dots per inch.

How Image Resolution Is Measured
Image resolution is usually measured in one of several ways: the number of total pixels

(image dimension in pixels), the size of the file (number of bytes, kilobytes, or megabytes),

or the amount of information per inch (ppi, or pixels per inch). One way of measuring the

file size is not necessarily better or worse than another, as long as you can consistently

achieve the desired result—without guesswork.

Measuring image resolution in total pixels or file size is not the most intuitive or useful

approach for most people working in Elements. Both of these are usually used to measure

source image size, such as with scans or images from digital cameras. While the measures

tell the quantity of image information in a file, the parameters don’t dictate how the infor-

mation is used. A 2100×1500 image in total pixels could be a 7×5 inch image at 300 ppi, 

or a 21×15 inch image at 100 ppi—and it can be used that way simultaneously. The num-

ber of pixels used in an image measured as total pixels is essentially arbitrary. An image
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measured with a file size of 12 MB might be about a third larger in RGB than CMYK. In

black-and-white (grayscale), a 12 MB image would be much larger still—about four times

the area of a 12 MB CMYK image. The lack of a controlling parameter to lock in the size 

of the image when using total pixels or file size keeps you from knowing exactly what you

have and how the image will be applied if you look at file size alone. File size is probably

the least-used measure of resolution, and it makes sense only in a workflow where color

mode is static (for example, images are either only RGB or only CMYK).

Most Elements users will use ppi as a measure of image resolution because it is the most

compatible in comparing to output resolutions. This type of measure tells how much of the

image pixel information should be applied per inch. Because printer resolution is most

often a finite measure (based on the printer’s dpi: how many printer dots can be made per

inch), using ppi measurement makes it easy to determine the optimal match between digi-

tal image information and what the printer will need to produce the best results.

What Image Resolution to Use
Some people generalize and suggest using 300 ppi as a standard resolution for images

going to print. For Web images is it usually accepted that images should be 72 ppi. While

these are pretty good as general-purpose guidelines, they don’t tell the entire story. 300 ppi

may be more than is necessary for all home printers, and may actually be too little for

demanding output (such as film recorder output). Because monitor resolutions can vary,

your 72 ppi image on a 96 dpi screen would actually be about 75 percent of the intended

size. Neither choice is likely to ruin your output, in most cases.

Because output differs, there is no one universal magic formula to figure out what reso-

lution to use. Each output type has a target range (minimum and maximum), based on its

capability to process and use image information. Once you know the range you need as a

result, you simply use that range as a target when working on an image. Know what your

service company or printer manufacturer recommends for output on the devices you use.

This may require reading the manuals or giving a call to the service company to find out.

The optimal range is the range where the image will perform the best in application; it is

possible to get acceptable results by going outside the range depending on how you imple-

ment the image and the results that you expect.

Table 1.2 shows the approximate resolutions you will want to use for your images,

depending on how you want to use them. An image sent to a device that uses a specified

output resolution should have a specific target ppi. The table shows some real-world

examples of output resolution and workable ppi ranges. Calculations for the table were

based on the formulas shown in the Calculation Used column; square brackets in the cal-

culations indicate the range of values used to determine the lowest and highest resolution

acceptable in that media.
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O U T P U T  A P P R O X I M A T E  I M A G E  C A L C U L A T I O N  

M E D I A R E S O L U T I O N F I L E  R E S O L U T I O N U S E D

Web 72–96 dpi (monitor) 72–96 ppi ppi = dpi

Inkjet (stochastic) 720 dpi 180–234 ppi [1 to 1.3] × (dpi / 4)

Inkjet (stochastic) 1440 dpi 360–468 ppi [1 to 1.3] × (dpi / 4)

Halftone, low resolution 75–100 lpi 116–200 ppi [1.55 to 2] × lpi

Halftone, normal 133–150 lpi 233–350 ppi [1.55 to 2] × lpi

Halftone, high resolution 175–200 lpi 271–400 ppi [1.55 to 2] × lpi

Line art 600–3000 dpi 600–1342 ppi (dpi/600)
1⁄2 × 600

Film recorder 4K (35mm) 2731×4096 pixels Total pixels

Film recorder 8K (6×9cm) 5461×8192 pixels Total pixels

Note that these resolutions are suggested and not absolute. Images will still print and dis-

play at other resolutions, but the results may not be predictable or efficient. Actual resolu-

tion needs may be somewhat flexible based on circumstances, such as paper and equipment

used, original image quality, expected results, and so forth. Be sure to read manufacturer

suggestions, and take most of the advice offered by service companies—they should know

how to get the best results from their equipment.

Resizing Images
Changing the size of an area that a group of pixels occupies can come in two forms: one

causes you to resample an image (using Bicubic, Bilinear, or Nearest Neighbor interpola-

tion), and the other changes the resolution to redistribute pixels over a smaller or larger area:

Redistributing pixels does nothing to actually change the content (mathematics) of

the image information that is stored; it just suggests that the content will be applied

over a different area.

Resampling, on the other hand, actually changes the content of your images, and

changes it permanently.

The larger the amount of resizing (the greater the percentage increase or decrease), the

more it affects the image content. One of these two things, redistributing or resampling,

has to happen each time you either change the size of the whole image (using Image Size,

not Canvas Size) or change the size of a selection by stretching or transforming.

When you upsample or downsample an image or image area and retain the resolution,

Photoshop Elements has to interpret and redistribute tonal and color information, either

creating (upsampling) or removing (downsampling) pixels. It does this through interpola-

tion (adding image information) or decimation (removing image information), which are

really fancy names for making an educated guess. Resampling an image to make it larger

will never fill in information that is not already there, no matter what you do and which

Table 1.2

Approximate 
Resolution for 
Various Media

resolution ■ 35

4385c01.qxd  11/7/04  11:27 PM  Page 35



plug-in you use. That trick you’ve seen on TV, where a pixelated image gets clearer and

clearer as they zoom in, is reverse engineered. The only thing you can really do to reclaim

image detail that you don’t already have is reshoot an image or rescan (assuming that the

detail is present in what you are scanning). What resampling will do is estimate and aver-

age differences between pixels to make a best guess. Details will tend to soften (upsample)

or be lost (downsample).

Photoshop Elements has three methods of interpolation (methods of figuring out how

to insert new pixels or remove existing ones as you change an image’s size), and five inter-

polation options. Nearest Neighbor, Bilinear, and Bicubic are the methods. Bicubic

Smoother and Bicubic Sharper are Bicubic interpolation options that have been added in

Elements 3.

Nearest Neighbor When you resize using Nearest Neighbor interpolation, Photoshop

Elements picks a representative color from those that already exist in the image. Whether

upsampling or downsampling, there is no averaging to create new colors or tones. Near-

est Neighbor is useful, for example, for controlled upsampling of screenshots without

blurring.

Bilinear Bilinear interpolation behaves much like Bicubic and is supposed to be faster, but

I’ve never clocked them. During the sampling, new tones and colors can be introduced

between existing colors that are not in the original image. This can blur sampling of hard

edges, but can provide a smooth transition for tones (Nearest Neighbor might provide a

blockier, stepped result). One thing about Bilinear upsampling is that it remains more

true to simple averaging between neighboring tones and adds fewer new qualities to an

image than Bicubic. At times these properties prove to be an advantage in retaining look

and feel, and in others they may result in softening. It is useful when you want a straight-

forward averaging, which may be useful when downsampling images.

Bicubic The resampling process creates new image information by averaging, like Bilinear,

but goes one step further to provide a tiny bit of sharpening to the result. This is intended to

counteract the blurring result of averaging. It changes a greater number of pixels with the

same radius setting as Bilinear, but may generally give a better visible result in most cases

than Bilinear. It is the real workhorse for sizing images. Bicubic Sharper is like Bicubic, but

with enhanced sharpening; Bicubic Smoother is like Bicubic, but with less sharpening.

While making up information and decimating it sound like bad things, each has its

purpose. Usually you should avoid upsampling—especially if the option exists for gaining

more detail through a better-targeted source image. However, images can be upsampled

with some success, depending on the desired quality—provided the change isn’t huge.
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Upsampling 10 percent or even 20 percent may not be noticeable if the source image is

sharp. Usually you will upsample only to make up small gaps (if necessary) between the

resolution you have in an image and what you really need, or to adjust borrowed image

components (elements you are compositing from other images).

Downsampling, while certainly damaging and compromising to image content,

should be less noticeable in your results. Image information indeed gets averaged or

eliminated, but if downsizing is being done for the right reason, any details you lose

would have been lost on output or display anyway. Detail loss is inherent in the process

of downsizing or outputting images at a smaller size: even if the equipment used could

reproduce detail at a smaller size, eventually details will pass the limit of the human eye’s

ability to discern them.

Multipurpose Images
Making images that you’ll use for more than one purpose (for example, print and Web)

can cause a little problem. Optimally, you’d like to work with images so that you target the

result. Doing so ensures that you retain all of the actual image detail rather than relying on

interpolation or decimation and your choice for sampling type to produce the right

results. It is a simple fact that an image going to print on a high-resolution printer should

have more information than one at the same size used on the Web, or you will not opti-

mize detail.

You have only two solutions in working with dual-purpose images:

• Create two images, each with a specific purpose.

• Create one image and resize.

Either of these choices poses a trade-off. In creating two images, you sacrifice valuable

time in repeating processes. It is often self-defeating to work on two images to produce the

same results (even using a detailed script) because the difference in size and volume of

information in the image will produce different results with the same application of tools.

In creating one image and resizing, you have to allow either interpolation of new image

information or decimation, which may not be the optimal process. You can’t work on

small images and resize up, because detail will not be present.

The best way to go about working with multipurpose images is usually to work with

them at the highest resolution and then resize them smaller. Working at the higher of two

or more resolutions retains the details for the higher-resolution presentations, and deci-

mates detail that will not be reproducible at lower resolutions. Softening or other ill-effects

from severe resizing can be countered somewhat by sharpening. (See “(Un)Sharpening and

Boosting Contrast” in Chapter 3 for more information on sharpening.)
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Knowing Your Equipment and Images
Part of working with images on your computer is learning the nuances of systems and

software, and having some idea about what you expect to do with the images. You are

responsible for knowing your equipment and the purpose of your images. This section

cannot help if you are having trouble with your computer system, but it can tell you what

to look for and where to get help. Similarly, it doesn’t tell you what exactly to do with

images but does present some general guidelines for how to proceed.

Know Your Equipment
Because all computers and systems are not alike, it is impossible to cover every nuance of

every system in every situation in one book. There are innumerable digital cameras on the

market, a plethora of ways to get the images off the cameras, and hundreds of home print-

ers to print the result to. Software configurations and utilities can cause fresh problems

while solving others, and compatibilities can be an issue with both hardware and software.

If you have trouble getting the images off your camera, or have trouble with your

printer or computer, the place to find answers is in the user manual for these devices and

through technical support from manufacturers.

The following is a short checklist of maintenance tasks you should recognize, under-

stand, and perform for your computer, peripherals, and software.

Scanners (and Analog Film)

• Calibrate your scanner per manufacturer suggestions.

• Maintain a regimen for cleaning the scanner and scanned objects.

• Be sure to use proper connections and connection settings.

• Consider having important images scanned by scanning services, which may have

better equipment and resolution than you may have at home (for example, scan nega-

tives and slides to a Kodak Photo CD rather than on a home flatbed scanner).

Digital Cameras

• Choose appropriate settings per manufacturer recommendations, and don’t change

settings if you don’t know what they do.

• Learn about special features and settings by reading the manual.

• Understand image control and exposure.

• Understand how to format camera storage.

• Know how to properly connect a camera to your computer and download images

from the camera.
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Printers

• Use appropriate paper and inks as suggested by the manufacturer.

• Read maintenance and cleaning suggestions and follow these practices rigorously.

• Don’t expect RGB results from a CMYK printer. CMYK is a smaller color space,

meaning there are simply fewer colors available.

Computer Software and Hardware

• Maintain a firewall if using an open Internet connection.

• Use virus protection software to minimize problems with infected digital files, espe-

cially if you trade a lot of files. Never open a file from an outside source (even a

known source) if it has not been scanned for viruses.

• Maintain a schedule of maintenance for data backup, disk error scanning, and associ-

ated digital maintenance (such as defragmenting).

• Check manufacturer websites regularly for software updates, bug fixes, and compati-

bility notices.

• Keep a log of program installations to help locate software conflicts.

• Don’t jump to conclusions. Note multiple problems in the operation of your system.

If you have problems with more than one program or device, there may be a common

link to the real cause.

• Simplify your system whenever possible by detaching chronically unused peripherals

and uninstalling unnecessary software.

Know Your Image
Some matters involved in repairing and compositing images are not really judgment calls,

and some are. One thing no book or manual can tell you is exactly what you want to do

with an image. While I can suggest proven ways of getting good results, learning to evalu-

ate an image’s composition and deciding what to do to improve it will be a judgment call.

Your judgment will improve over time and with practice.

Don’t ever say it is good enough if it isn’t good enough. Give up on an image only

when it is not worth the effort to improve it. There is almost nothing you can’t do with an

image if you have the desire. You can also correct the same image from now until dooms-

day, improving it in increments all the time. Sometimes putting an image aside for a day

or two can give you a new perspective: when you come back to it, you may see solutions

you hadn’t previously considered. Solutions won’t always jump out at you, and sometimes
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you’ll have to manufacture them. In trying to stretch your limitations, no matter what you

are attempting to do to an image, chances are you will learn from each solution you

attempt.

The more you work with images, the easier and quicker the manipulations will become.

Now let’s push some pixels…
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